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Troubleshooting Federal
Child Count Reports
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The Ohio Department of Education funds development of EMIS training materials
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these
materials in training provided to your districts. That said, there are restrictions on
use of the EMIS Alliance materials as follows: Materials developed as part of the
EMIS Alliance program must be provided at no cost to your training participants. If
you utilize the EMIS Alliance training materials — in whole or in part — you must not
charge participants a fee to attend the class where the materials are used. Likewise,
you may not use the materials or any portion thereof in any event where a fee is
charged to attend. Exceptions must be approved in writing by the Department of
Education in advance of scheduling/promoting any event which may violate these
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.gov].
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Overview
* The Federal Child Count (FCC)

* Includes students with disabilities who are receiving special education
services according to their IEPs as of October 31

* |s used in determining the amount of Special Education Part-B IDEA
and Early Childhood Special Education funds allocated to the state

* |s collected from all LEAs except for ESCs and JVSDs through the
Education Management Information System (EMIS) and is submitted
to the US Department of Education (USDOE)

* This presentation will focus on troubleshooting the EMIS FCC
Reports, which are generated throughout the EMIS data
submission process
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EMIS Data Collections and the FCC Snapshot

* Collections containing the FCC report
* Beginning of Year Student (S) Collection
* SOES Beginning of Year Student (S) Collection

* Collections are scheduled to close December 19, 2022
* FCC will close when the above collections close
* There is no appeal for the FCC
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FCC Reports

* Level 2 Reports
* (FCCD-001) Federal Child Count Detail
* (FCCS-001) Federal Child Count Statement of Assurances

* FCC Reports are updated nightly
* Can contain data reported by other LEAs

* Review the most recent version of the reports throughout the
data collection process

* Submit updated EMIS data to make corrections to the reports
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| Beginning_of Year Student Collection (FY23)
FY23-5<TRAD Init: Collection required for all Traditional Districts, JVSDs, ESCs, and State Supported Schools. Source file(s) for GL. FS, FD. FN. GD. ... §
Submissions: August 15, 2022 - December 19, 2022 (45 days till closs)
Version: 2
Status: The collection was submitted November 01, 2022 at 03:53:03 PM by
ion Status: i ( 01, 2022 at 03:53:22 PM)
Submission Numbe:
Action:
SOES Beginning of Year Student Collection (FY23)
FY23-5-S0ES Init: Collection required for all Community Schools. Source file{s) far FC, FD, PBWEL FN, FR, FS, GO, GE, GG, GI, G GQ ol
Submissions: August 01, 2022 - December 19, 2022 (45 days till close)
Varsion: 4 From ODE: Laval 2 Ragorts
Status: The collection was submitted October 26, 2022 at 04:03:23 PM by
! ion Status: ing Completed (October 26, 2022 at 04:05:32 PM)
Submission Number: 2 (sttempt 2) Submit Errors: Nons (has gther errors or warnings)
Actions: = Prepare Outputs: Level 1 Validations
Al Collectign iy migsion i1
b1 n properties
\ EMIS
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Collection Requests = Collecti ions 55

. FCC Reports

Data Feedback Reports and Files
Pre-Submission to ODE I
Leal 3 Dataily

Post-Submission and Processing by ODE
1 Highlighty and Barert | Llavel2Detalls | ~ Escwved £b
Level 2 Details

Choose the filter criteria then click the Show Reports link to generate the list of Level 2 reports matching these criteria. To see the option to Generate a single .zip file for all
reports (.csv), you must select a single Report Name, or select a single LEA an i i

a single Collection Request or a single Category.

LEA: | Usa 1N below v Collection Request: | FY23-5-TRAD Init v
LEA TRN: |

ReportMame: (2l |

Pracessed on or after:

L 1 Category: | 4 W
Last Activity Withini (41~
Updated an grall ]

With Data Only: () Exchde raports with 0 rovs

FCC was added to the
filter in this example

14 Count Datas

Formatting the FCC Detail Report
* Open the (FCCD-001) Federal Child Count Detail Report
* Wrap text header row
* Freeze top row
* Expand all columns
* Apply filters
* Better yet, run your macro!

11/10/2022
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Quick Check

The Federal Child Count Detail
Report contains student detail
data as it pertains to the
count. This report is critical in
the data review and error
correction process and should
be carefully reviewed for
accuracy and completeness.

* Are you using the most recent
version of the report?

* Are you able to open and format
the CSV report to begin the review
process?

* Can you apply filters to all
columns?

EMIS

S 9
i -
Alliance

Troubleshooting
the Federal Child Count
Detail Report
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Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the
report including

* Severity Codes and Numbers

* Federal Child Count Flag

* Who is and is not included in my FCC?

* FCC Report Data
:f * Status Codes and corrective actions

EMIS

s
Alliance

| Severity Codes

Severity Codes
\ * Report is sorted least severe to most severe
* Severity Code will be noted for each Status Code
* Review all students regardless of Severity Code

A E C D E F G H | dl

FED CCT
SEVERITY STATUS
1 |LEA IRN Bldg IRN CODE SSID Emis ID Last Name First Name Middle Name CODE  FED CCT STATUS CODE DESCR
2 | 404040 22020 | QM7428739 B18000002 Last Name First Name Middle Name FCO008 No errors identified in ODE processing
I 3 | 404040 110101 QN7115296 B18000003 Last Name First Name Middle Name FCO008 No errors identified in ODE processing
f 4 | 404040 22020 1 TB4261518  R13000004 |ast Name First NMame Middle Name FC0008 No errors identified in ODE processing
5 | 404040 22020 | 3460 I —_ Informational ddle Name FCO008 No errors identified in ODE processing

\ W - Warning
C — Critical
F - Fatal Eha

Thayg 12
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Federal Child Count Flag

FED CCT FLAG
* Y —Student is intended to be included in the Federal Child Count
* N — Student not included in the Federal Child Count
* Review all students on the report regardless of flag

| 1 K L M N (o] P Q R
FED CCT LEGAL DISAB STDNT DISTLRE
STATUS FEDCCT |FEDCCT DISTOF CNDTN AGE SRC FED CCT
CODE FED CCT STATUS CODE DESCR FLAG LRE CODE RESIRN CODE NUMBER CODE DIST LRE SRC DESCR ALT IRN
FCO008  No errors identified in ODE processing Y IE1S 404040 15 8 8 GE Record
FCO008  Noerrors identified in ODE processing Y IESS 404040 5 4 8 GE Record
FC0005  Student does not meet inclusion filter in this district N 46400 15 10 5 No IEP Reported
FC0005  Student does not meet inclusion filter in this district N 46100 14 13 5 No IEP Reported
FC0004  No IEP reported for Oct 31 date N 404040 5 6 5 No IEP Reported
EMIS
S 13
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Who is included in my FCC?

* In most cases, students count at their resident district except for
students attending -
* Community Schools
* STEM Districts
+ Ohio-Schoolforthe Blind
+ Ohio-Schoolforthe Deaf
* Buckeye United (DYS)
+ Pilot-Programs

* Non-Public students receiving related services count at the traditional
district providing the related services if active IEP event is reported as of
October 31

EMIS
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Who is not included in my FCC?

* Students with a disability as of October 31, who are not
being reported with an active IEP event as of October 31

* Students reported with the following IEP outcomes
* [EPR — IEP Complete — Parental Refusal
* [ENS — IEP Complete — Not Served
* |EDP — IEP Resulted in Due Process

* Refer to the FCC Level 2 Report Explanation, section “Include
in USDOE Count” for additional information and exceptions

EMIS
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FCC Report Data

* Disability Condition Code
* Student must be reported to EMIS with a disability as of October
31 to be included on the report

* Review for accuracy

* Student Age Number
* Student’s age as of October 31

I 1 K L M N o] P Q R
FEDCCT LEGAL DISAB STDNT DIST LRE
STATUS FEDCCT FEDCCT DISTOF [CNDTN  AGE SRC FEDCCT
CODE FED CCT STATUS CODE DESCR FLAG LRE CODE RESIRN |CODE NUMBER |CODE DIST LRE SRC DESCR ALT IRN
FCO008  No errors identified in ODE processing Y IE15 404040| 15 8| 8 GE Record
FCO00B  No errors identified in ODE processing A IES5 404040 5 4 8 GE Record
FC0005  Student does not meet inclusion filter in this district N 46400| 15 10| 5 Mo IEP Reported
FC0005  Student does not meet inclusion filter in this district N 46100| 14 13 5 No IEP Reported
FCO00M4  No IEP reported for Oct 31 date N 404040 5 6 5 Mo IEP Reported

EMIS
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FCC Report Data, cont’d

* Legal District of Residence

* FED CCT ALT IRN
* Populated for Status Code FCO006 with LEA IRN where the student will count

* Sent Reasons and IRNs
* Displays if relevant to the FCC

L ) N Q0 P Q R s T u v W X
LEGAL DISAB STDNT DIST LRE SENT SENT LEVEL 2
FEDCCT |DISTOF |CNDTN AGE SRC FEDCCT |ADMSN |REASON SENTTO REASOMN SENTTO |REC TYPE
LRE CODE|RES IRN |CODE NUMBER CODE DIST LRE SRC DESCR ALTIRN |DATE 1CODE 1LEAIRN 2CODE 2LEAIRN |CODE
IE15 404040 15 8 GE Record 00:00.0| FCCD-001
044555 15 5 7 FN270 Override 044555 00:00.0| FCCD-001
043111 8 8 GE Record 043111 00:00.0] FCCD-001
044444 15 19 8 GE Record 044444]  00:00.0f FCCD-001
046666) 6 17 8 GE Record 046666| 00:00.000V 050008 FCCD-001
404040 3 17 8 GE Record 404040]  00:00.00FC 043444 FCCD-001
EMIS
TS 17
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FCC Report Data, cont’d

* FED CCT LRE Code — Least Restrictive Environment Code
* If this is blank, the student is not included in the count
* Value comes from IEP, FN270, or is derived

* DIST LRE SRC CODE and DIST LRE SRC DESCR
* Source codes indicate what data the report is looking at

* Use in combination with the Status Code value to determine what is being
reported for each student

| J K L M M o] P Q
FED CCT LEGAL DISAB STDNT DIST LRE
STATUS FED CCT |FEDCCT |DISTOF CNDTN  AGE SRC
CODE FED CCT STATUS CODE DESCR FLAG LRECODE|RES IRN  CODE NUMBER |CODE DIST LRE SRC DESCR

FCO008  No errors identified in ODE processing ¥ IE1S 404040 15 8| 8 GE Record
FCO008 Mo errors identified in ODE processing ¥ IESS 404040 5 4 8 GE Record
FCO008  No errors identified in ODE processing ¥ IE1S 404040 15 8| 8 GE Record
FCO008  No errors identified in ODE processing Y IE39 041010 5 9 9 How Received =6
FCO008  No errors identified in ODE processing ¥ IE39 404040 1 8| A Sent Reason =AU or JP
EMIS
VoS 18
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DIST LRE Source Codes

* 1 - No Disability on October 31
* 3 - Student’s age is not 3 -21
*5-No IEP Reported
*7-FN270 Override

* 8 - GE Record

| 1 K L I N (o] P Q
FEDCCT LEGAL DISAB STDNT DIST LRE
STATUS FEDCCT FEDCCT DISTOF CNDTN AGE SRC
CODE FED CCT STATUS CODE DESCR FLAG LRECODE RESIRN CODE NUMBER |CODE DIST LRE SRC DESCR
FCO008  No errors identified in ODE processing ¥ IE1S 404040 15 8| 8 GE Record
FCO008 Mo errors identified in ODE processing ¥ IESS 404040 5 4 8 GE Record
FCO008  No errors identified in ODE processing ¥ IE1S 404040 15 8| 8 GE Record
FCO008  No errors identified in ODE processing Y IE39 041010 5 9 9 How Received =6
FCO008  No errors identified in ODE processing ¥ IE39 404040 1 8| A Sent Reason =AU or JP
EMIS
TV 19
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DIST LRE Source Codes, cont’d
* 9 - How Received = 6
* FED CCT LRE CODE will be IE39 Ages 5 and up, Not Grade Level PS
* FED CCT LRE CODE will be IE39 Ages 6 and up, Grade Level PS
* C- How Received = 6 and Grade Level =PS
* FED CCT LRE CODE will be IE51 if Ages 3 to 5 and Grade Level PS
* A -Sent Reason = AU or JP
* FED CCT LRE CODE will be IE39 if age 6 or older and IE51 if age 3-5
* B - Changed to DYS LRE (Appears only on DYS report)
| J K L M N 0 P Q
FED CCT LEGAL DISAB STDNT  |DIST LRE
STATUS FEDCCT FEDCCT DISTOF CNDTN AGE SRC
CODE FED CCT STATUS CODE DESCR FLAG LRE CODE RESIRN CODE NUMBER |CODE DIST LRE SRC DESCR
FCO008  No errors identified in ODE processing Y IE15 404040 15 8 8 GE Record
FCO008  No errors identified in ODE processing Y IESS 404040 5 4 8 GE Record
FCO008  No errors identified in ODE processing Y IE1S 404040 15 8 8 GE Record
FCO008  No errors identified in ODE processing ¥ IE39 041010 5 9 9 How Received =6 EMIS
FCO008  No errors identified in ODE processing Y IE39 404040 1 8 A SentReason =AU or JP
\ Yan T 20
Alliance
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Quick Check

The Federal Child Count Detail

Report contains data specific
to students with disabilities.
Understanding each column
of data is important to begin
analyzing the data for
accuracy and completeness.
There is not an error for
everything, so time spent
reviewing all data on the
report is recommended.

* Are all students appearing on the

report as expected?

* Has someone verified the data for

accuracy?

* Has updated EMIS data been

submitted to correct any

inaccuracies on the report?

EMIS
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FED CCT Status Codes

FED CCT STATUS CODE and FED CCT STATUS CODE DESCR
* Indicates the status of a student as it relates to inclusion in the count
* Indicates that a data issue exists or that no errors are identified
* Data with no errors on the report should still be reviewed for accuracy

E F G H | 1 K L M N
FED CCT LEGAL DISAB
STATUS FEDCCT FEDCCT DISTOF CNDTN
Emis ID Last Mame First Name Middle Name |CODE FED CCT STATUS CODE DESCR FLAG LRE CODE RESIRN CODE
B18000002 Last Name First Name Middle Name |FC0008  No errors identified in ODE processing Y IE15 404040 15
B18000003 Last Name First Name Middle Name |FCO008 Mo errors identified in ODE processing Y IESS 404040 5
B18000004 Last Name First Name Middle Name |FC0008 Mo errors identified in ODE processing Y IE1S 404040 15
B18000024 Last Name First Name Middle Name |FC0008  No errors identified in ODE processing Y IE33 041010 5
B18000029 Last Name First Name Middle Name |FC0008 Mo errors identified in ODE processing Y IE39 404040 1
EMIS
N 22
Alliance

11



11/10/2022

FED CCT Status Code FC0001

Filter on FCO001

* On Oct 31 Student age is outside the 3-21 included range (Fatal)
* Source Code 3 - Student age is not 3 —21
* FED CCT FLAG - N

* View the student’s reported date of birth on the Student
Demographic (Gl) Record to confirm age

* If the student’s date of birth is incorrect, make the correction and
submit updated EMIS data

EMIS

Alliance

FED CCT Status Code FC0002

Filter on FC0002

* Unable to translate LRE-must report FN270 element (Critical)
* Source Code 7 - FN270 Override
* or Source Code 8 - GE Record
* FED CCT Flag - N
* As of October 31, the student’s IEP Outcome (LRE) must agree
with the student’s age and grade level

* For ages 3-5 and in preschool, the LRE should be in the IE51 to IE72
range, if not report an LRE within this range on the FN270

* For ages 5 and over and in kindergarten or higher, LRE should be in
’Ic:I'Im\lezl7EO13 to IE39 range, if not report an LRE within this range on the

EMIS

24
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Age, Grade Level, and Expected LRE

* Age 3 to 5, Preschool Grade Level - Count as Preschool Student
* Preschool LRE Expected (IE51-1E72)

* Age 4, Kindergarten Grade Level - Count as Preschool Student
* Preschool LRE Expected (IE51-1E72)
* Age 5 and up, Kindergarten Grade Level - Count as School Aged
Student
* School Aged LRE Expected (IE13-1E39)
* Age 6 and up, Any Grade Level, including Preschool - Count as
School Aged Student
* School Aged LRE Expected (IE13-1E39)

EMIS

N »
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Reporting the FN270 Element
Updated October 31 IEP Outcome Element (FN270)

* The current IEP outcome and FN270 values should not be the same

* When the FN270 value is reported correctly the LRE that aligns with
the student’s age and grade level will appear in the column FED CCT

* When reported incorrectly the FED CCT LRE CODE column will be
blank
| J K L M N o P Q
FED CCT LEGAL DISAB STDNT DIST LRE
STATUS Correct FEDCCT FEDCCT DISTOF CNDTN  AGE SRC
CODE FED CCT STATUS CODE DESCR \LLAG LRE CODE RESIRN CODE NUMBER CODE DIST LRE SRC DESCR
FCO008  No errors identified in ODE processing Y E15 404040 15 a 8 GE Record
FCO008  No errors identified in ODE processing Y IESS 404040 5 4 8 GE Record
FCO002  Unable to translate LRE- must report FN270 element N 404040 6 5 8 GE Record
FCD002  Unable to translate LRE- must report FN270 element N 404040 5 5 7 FN270 Override
FCO002Z  Unable to translate LRE- must report FN270 element N / 404040 15 5 7 FN270 Override
L~ EMIS
Incorrect o

o
Alliance
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Additional Information on FN270 Reporting

* When completing the Federal Child Count, the Department will
review the LRE on the latest reported IEP event effective as of

October 31
* The value the FN270 element will take precedence
* Reporting of an FN270 value is not limited to PS and KG

* For this element to be valid for the Federal Child Count, the
student must already have an IEP reported to the Department
that is valid on October 31. If no reported IEP is valid on October
31, then the value in this element will be ignored

EMIS
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Additional Information on FN270 Reporting, cont’d

In general, the LRE will not change without a new IEP being
completed and reported, but there are some cases, especially
with IEPs reported in the prior year that are still in effect on
October 31, where the LRE could change

* Examples include but are not limited to

* a student whose parent originally consented to services but pulled the student
from services prior to October 31

* situations where an expelled student is given an alternative placement that will
be in effect on October 31

* a preschool student (especially for those who are part time), a parental
placement in a private preschool program could change the LRE for that
student

* Questions on FN270 reporting should go to the ODE EMIS Helpdesk

14
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FED CCT Status Code FCO003

Filter on FCO003

* CIEP most recent IEP - should be no disability (Warning)
* Source Code 8 - GE Record
* FEDCCTFLAG-N
* Verify the CIEP event and confirm that the student’s disability code
is being reported as ending on the date of the CIEP event

* If the student’s disability code on the Student Attributes - Effective

Date (FD) Record is not reported as ended, make the correction
and submit updated EMIS data

EMIS

h 29
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FED CCT Status Code FCO004

Filter on FCO004

* No IEP reported for Oct 31 date (Fatal)
* Source Code 5 - No IEP Reported
* FED CCT Flag—N
* FED CCT LRE CODE - Blank

* Verify the student’s special education event records as of October 31
* Verify the most recent IEP was reported to EMIS
* Report an NIEP if appropriate

EMIS
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ODDEX Records

Special Education Data Tab
* Use to verify if the student’s IEP events were reported to EMIS

Ohio Department  Ohio District Data Exchange (ODDEX)

Records Single Student

Home SOES SCR SCM Records

CCP Tuition

Special Education Assessments Grad Cohort
= | Return to Summary @ Help

Name ssio Birthdate

ODDEX Help Log Out

History

Event Date Event Type Outcome Outcome Dates Non-Compliance Secondary Planning Required Test Type Reported by LEA
01/27/2022 RIEP IE15 01/31/2022 - 01/26/2023 N/A TFYG STA
03/02/2021 RIEP IE15 03/05/2021 - 03/01/2022 N/A TFYG STA
03132020  RETR ET13 N/A NIA N/A
031132020  RIEP IE15 03/47/2020 - 03412/2021 N/A TFYG ALT
EMIS
WapsS T 31
Alliance

NIEP Date Type - No IEP

* NIEP events for expired or non-transferable IEPs
* 10 - Student newly transferred in; IEP adoption determination not
complete; services being provided based on prior IEP

* 11 - IEP expired; new IEP not in place; services being provided
based on prior IEP

* NIEP events using the non-compliance reason of 12 can be
used until the end of the IEP that did not get reported to
EMIS

EMIS

VoS 32
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FED CCT Status Code FCO005

Filter on FCO005

* Student does not meet inclusion filter in this district (Warning)
* Source Code 5 - No IEP Reported
* or Source Code 7 - FN270 Override
* or Source Code 8 - GE Record
* FED CCT Flag—N

* Shared students can have this Status Code at the educating district

* Shared students where |IEPs are not reported can also have this
Status Code with Source Code 5 — No IEP Reported

* Refer to the Federal Child Count Report Explanation, section “Include
in USDOE Count”

EMIS

Alliance

FED CCT Status Code FC0005, cont’d

Filter on FCO005

* Student does not meet inclusion filter in this district (Warning)
* Source Code 9 — How Received = 6
* FED CCT Flag—N
* Non-Public special education students receiving related services
from reporting district with No IEP reported on October 31
* Report does not consider ISPs

* If no IEP in place on October 31, then the student is not included in
the FCC

EMIS

S 34
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Multiple District Tie Breakers

1. Will count at Buckeye United if reported by Buckeye United (060988)
2. Will count where Reporting IRN = District of Residence IRN
~OR~ counts where Reporting IRN is reporting a How Received code of
M (Community School) or K (STEM District)

3. If multiple entities are claiming the student in the same way (as #2
above), then the student is included at the entity with the later
admission date

4. If entities are claiming the student in the same way (as #2 above) and
reporting the student with the same admission date, then the student
will not count for any district

EMIS

> 35
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FED CCT Status Code FCO006

Filter on FCO006
 Student counting in alternative district - does not count in your
district (Warning)
* Source Code 5 — No IEP Reported - verify if special education events need to
be reported for this student

* or Source Code 7 - FN270 Override
* or Source Code 8 - GE Record
* or Source Code 9 - How Received = 6
* or Source Code A - Sent Reason AU or JP
« FED CCT Flag - N

* Student counts at the IRN in the FED CCT ALT IRN column

* Review data in ODDEX to compare how data is being reported
* Communicate with the alternative district to determine how this
student should be reported

EMIS

S 36
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FED CCT Status Code FCO007

Filter on FCO007

* Student excluded -conflict in where student should count (Fatal)
* Source Code —7 FN270 Override
* Or Source Code — 8 GE Record
* FEDCCT Flag-N
* Could not determine where this student should count, so the student
will not be counted at either entity
* Review data in ODDEX to compare how data is being reported by both
entities

* Communicate with the other entity to determine how this student
should be reported

EMIS
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FED CCT Status Code FCO008

Filter on FCO0O08

* No errors identified in ODE processing (Informational)
* Source Code 7 —FN270 Override
* or Source Code 8 — GE Record
* or Source Code 9 — How Received = 6
* or Source Code A — Sent Reason = AU or JP
* or Source Code B — Changed to DYS LRE (appears on Buckeye United FCC Report)
* or Source Code C— How Received = 6 and Grade = PS
* FED CCT Flag—-Y

* Data for the students should be reviewed for accuracy

* Apply filters to verify elements such as disability conditions and LREs

* District staff can be very helpful in verifying data accuracy and
completeness

EMIS

Alliance
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Quick Check

The Federal Child Count Detail
report will display students
who are and who are not
included in your count. The
report will also indicate
students with issues
preventing them from being
included. Check this report
often as it can be affected by
another entity’s EMIS
reporting.

* Have all status codes been
reviewed, and all reporting issues
corrected?

* When corrections have been
made in the student information
system (SIS), has that updated
data been submitted to EMIS?

* Based on inclusion criteria are all
of your special education students
being counted correctly?

EMIS
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Troubleshooting
the Federal Child Count Statement of
Assurances Report

20
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Open the FCC Statement of Assurances Report

1

@~ o W N

10
1
12
13
14
15
16

A
DISAB
CNDTN
CODE

B

DISABILITY DESCR
3, 4, and 5 Year Olds With a disability (Any)
1 Multiple Disabilities (other than Deaf-Blind)
2 Deaf-Blindness
3 Deafness (Hearing Impairment)
4 Visual Impairments
5 Speech and Language Impairments
6 Orthopedic Impairments
8 Emotional Disturbance (SBH)
9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua
10 Specific Learning Disabilities
12 Autism
13 Traumatic Brain Injury (TBI)
14 Qther Health Impaired (Major)
15 Other Health Impaired (Minor)
16 Developmental Delay

C

STUDENT
COUNTS

32

25

1

11

5

40

10

21

9

93

11

7

3

56

0

-

Format the report
by wrapping the
text in the header
row and expanding
all columns

EMIS
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Understanding Statement of Assurances

* The report includes

* only students who have a FED CCT Flag=Y

* all students age 3 to 5 in the first category
* students age 6 to 21 in each disability specific category

* Using the above criteria, the next series of slides will match
the FCC Detail Report against the FCC Statement of
Assurances Report

* When you are told that the counts on this report are
incorrect, filtering allows you to show which students are
included or not included

EMIS

h 42
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Filter on FCC CCT Flag

D E F G H J K L
FEDCCT
STATUS FEDCCT  FEDCCT
SSID T |Emis ID | v |Last Nan v First Nan v Middle Na v CODE | -|FED CCT STATUS CODE DESCR v |FLAG  |*|LRECOD[~
QM7428739 B18000002 rs identified in ODE processing #4=%or Ato Z IE15
anrsass mueoonccz | S€lect Y on the rs identified in TSNg I sot7ioh 1ES5
TB4261518 B18000004 . s ) ‘ed in ODE processing IE15
Sart by Color 3
0W3460935 B13000005 FED CCT Flag Fllter on {dentified in ODE processing — IE13
EW1274558 B18000006 H ied in ODE processing IES5
SK6324743  B1B000007 the Fcc Detall Report ODE processing IE13
0X9293910 B18000008 Last Name First Name Middle Name FCO008 No errors identified in rocessing Text Filters » |IE1IS
7B4868490 B18000009 Last Name FirstName Middle Name FCO008 Mo errors identified in ODE pPdgssing IE13
RM9418368 B18000010 - - identified in ODE proces search 2! ieso
5
. e - . W] [Select All)
:é::z:;l: siszgggﬁ These are the Students rsfjentl?e:fn ODE processing o IE15
. . Irs identified in ODE processing IE1S
TB6447729 B13000013 Who are |nc|uded N Irs identified in ODE processing IESS
772700507 B18000014 Irs identified in ODE processing IE13
raaoss2n psooo7] the Statement of s identified in ODE processing IE51
VF3038616 B18000018 Irs identified in ODE processing IE13
usz2sss02 exsooonzs| ASSUrances Report s identified in ODE processing IE13
UX9878688 B18000020 ‘crsrrrerme—rmrrresm ooy o reor=rrors identified in ODE processing IE13
ST7459855 B18000021 Last Name FirstName Middle Name FC0008 No errors identified in ODE processing IE13
FU1648338 B18000024 Last Name FirstName Middle Name FCO008  No errors identified in ODE processing Goneel | IE39
SX4837190 B18000025 Last Name FirstName Middle Name FCO00S No errors identified in ODE processing IE13
EMIS
. "‘fi':“‘ w43
Alliance
Add Second Filter on Student Age Number
G H J L M N o
FED CCT LEGAL DISAB STDNT
STATUS FED CCT FED CCT DISTOF CNDTN  AGE
First Nan v | Middle Nam ~ |CODE | -4|FED CCT STATUS Ct | [FLAG ~ |LRECOD|~ |RESIRN ~ |CODE |~ |NUMBH |
First Name Middle Name FCO008 Mo errors identifi SeIeCt ages 3: 4 and ¥ 4] Sort Smallest to Largest
First Name Middle Name FCO008 No errors identifi Y Z| SortLargest to Smallest
First Name Middle Name FC0008 No errors identifi 5 on the StUdent Age kd Sort by Color e
First Name Middle Name FCO008 No errors identifi H k4 i3
First Name Middle Name FCO008 No errors identifi Number Fllter
First Name Middle Name FCO008 Mo errors identified I ODE processing %
First Name Middle Name FCO008 Mo errors identified in ODE processing ¥ Mumber Filters »
First Name Middle Name FC0008 Mo errors identified in ODE processing Y o 5
Searc
First Name Middle Name FCOD03 No errors identified in ODE processing Y
First Name Middle Name FCO008 Mo errors identified in ODE processing Y E[:e\e:tml] Gl
First Name Middle Na 3
rstname widdlenanf These students are included in the 3, s
First Name Middle Na 5|
- = . . ope e
rrsname micdienan 4, and 5-year-olds with any disability L
First Name Middle Na Os
Firstvame vidienan] ON the Statement of Assurances report Os
First Name Middle Na O1o v
First Name Middle Name FC0008 Mo errors identified in ODE processing Y -
First Name Middle Name FCOD0Z Mo errors identified in ODE processing Y Cancel
First Name Middle Name FCO008 Mo errors identified in ODE processing Y
EMIS
- ‘q,‘:x‘;a‘ . 44
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Matching Data Between Reports

K L M N o

2. This will match the count on the Statement of ¢
! oeer rocer b S A curances.
1 < IFLAG _[3¥]LRE CODI~ |RES IRN | CODE [~ | NUMBEY DET
v = 404040 05 a2 GE Recort LINUTIN 3
\\ £ processing v = 402040 16 58 GE Record 1 |CODE DISABILITY DESCR COUNTS
e processing v ess  aosos0 0s 3 € Record
- — < - 3, 4, and § Year Olds With a disabily (Any) 3
1. From the filtered students on the FCC Detail Report, [:-.... 3 1 Multiple Disabiliies (other than Deaf-Blind) 2%
Override
select a range of cells and see the “count” appear at o |y 9 Deaf-Blindness 1
Override
the bottom of the spreadsheet. overnde || g 3 Deafness (Hearing Impairment) 1
< brocessing 7 ot T w5 ctreoa |6 4 Visual Impairments 5
 Procesing 7 oo N oioso o1 A e 5 Speech and Language Impairments |
E processing \a =3 05 ac How Received = . .
£ processing v iEs0 2 38 GE Record 8 6 Orthopedic Impairments 10
E processing \a 1E55 16 58 GE Record R 8
E processing \4 ess 38 GE Record 9 8 Emotional Disturbance (SBH) 21
E processing \a 1E55 404040 a7 FN270 Override
£ processing v €55 404040 38 GE Record 10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 9
e
processing \a IE55 404040 12 38 GE Record
e v e e b 22 o pecor 11 10 Specific Learning Disabilities 93
e S B B S [N T 1
e Erocensing B T vy TE| 13 Traumatic Brain Injury (TBI) 7
 Procering B s Jsotot0 Jos i cners |14 14 Other Health Impaired (Major) 3
 processin v PR 5 210 Overnde
i ¢ 15 15 Other Health Impaired (Minor) 56
s —|16 16 Developmental Delay 0

EMIS
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Normal Page Break Page Custom [ Gridiines [ Headings

Home  Inset Pagelayout  Formulas  Data

—
omuner | Q[ B
100

% Zoom to

Zoom

Preview Layout Views Selection
‘Workbook Views Show Zoom
E25 2 I
A B C

DISAB

CNDTN STUDENT
1 |CODE  DISABILITY DESCR COUNTS
2 |- 3,4, and 5 Year Olds With a disability (Any) 32
3 1 Multiple Disabilities (other than Deaf-Blind) 25
4 2 Deaf-Blindness 1
5 3 Deafness (Hearing Impairment) 11
& 4 Visual Impairments 5
7 5 speech and Language Impairments 40
8 6 Orthopedic Impairments 10
9 & Emotional Disturbance (SBH) 21
10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 9
1 10 Specific Learning Disabi 93
12 12 Autism 11
13 13 Traumatic Brain Injury (TBI) 7
14 14 Other Health Impaired (Major) E
15 15 Other Health Impaired (Minor) 56
16 16 Developmental Delay ]

Help

With two spreadsheets
open at the same time,
from the View tab select
“Arrange All” and then

ACROBAT  Q Tell mewi

‘Window
aw H »n {u, ”
Vertical” and “OK
D E F G H J
Arrange Windows 7 x
Arrange
O Tiled

O Herizontal
iVerticail
O Cascade

[] windows of active workbook

Cancel

EMIS
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 Arra nge All cont’d

“Arrange All” allows
both spreadsheets to

A B C B A B © .
| T oms be viewable at the
CNDTN STUDENT 1
SEVERITY same time
1 |CODE DISABILITY DESCR COUNTS 1 |LEAIRN =] BIdg IRT=]CODE [~]ssID
2 |- 3,4, and 5 Year Olds With a disability (Any) 32| |87]a0s000 011010 | QN7115296 B18000003 Last Name First Name Middle Name
3 1 Multiple Disabilities (other than Deaf-Blind) 25 90 404040 011010 | EW1274558 B18000006 Last Name First Name Middle Name
4 2 Deaf-Blindness 1 94404020 011010 1 RM9418368 B18000010 Last Name First Name Middle Name
5 3 Deafness (Hearing Impairment) 11| |97 404020 011010 1 TB6447729  B18000013 Last Name First Name Middle Name
. 2| visual Imnai 5| |0 ouoto FB4095299 B18000017 Last Name First Name Middle Name
isual Impairments : 1161404040 011010 | VT8988219 B18000042 Last Name First Name Middle Name
7 5 Speech and Language Impairments 40| 117404000 011010 1 SW6245323 B18000043 Last Name First Name Middle Name
8 6 Orthopedic Impairments 10| (123404000 011010 | TZ4890112 B18000051 Last Name First Name Middle Name
9 8 Emotional Disturbance (SBH) 21| [124/a02000 011010 1 RS6270130 B18000052 Last Name First Name Middle Name
10 9 Intellectual Disabilities (Formerly Mental Retardation or -see Manua g| (136404040 011010 | PT7315091 B18000073 Last Name First Name Middle Name
i R 146404040 011010 | TV9275263  B180000BS Last Name First Name Middle Name
" 10 Specific Learning Disabilities 93 . 5
B 152404040 011010 | JB1322486 B18000091 Last Name First Name Middle Name
2 13| Autism 111 1153400000 011010 1 BM4655536 B18000095 Last Name First Name Middle Name
13 13 Traumatic Brain Injury (TBI) 7| 158404000 011010 1 HOB860533 B18000101 Last Name First Name Middle Name
14 14 Other Health Impaired (Major) 3| |[162/404040 011010 | TW3264352 B18000108 Last Name First Name Middle Name
15 15 Other Health Impaired (Minor) 56 175/404040 011010 | VI2948567  B18000127 Last Name First Name Middle Name
16 16 Developmental Delay ol [182400020 011010 1 VL1309879 B18000155 Last Name First Name Middle Name
. 192404040 011010 | NL6849538 B18000158 Last Name First Name Middle Name
\ EMIS
NS 47
\ Alliance
|
Change the Student Age Filter
| J K L M N o
[
FED CCT LEGAL  DISAB  STDNT
STATUS FEDCCT FEDCCT DISTOF CNDTN  AGE
CODE |.1|FED CCT STATUS CODE DESCR ~ |FLAG v T LRE COD| ~ | RES IRN ~ | CODE |~ |NUMEE ~ |
FCOO008 No errors identified in ODE processing 2| Sort Smallest to Largest
FCOO Noerrorsidentified in ODE oro Y %l SCI‘tLdIgEEttC Smallest
= Leave the FED CCT Flag y Sort by Color ,
FC000} Y
FCOO0O} H Y
Column filter set to
FCO00| Y
roool show only Y values v Numer Eiters ’
FC000| Y
Search
FCO008 No errors identified in ODE processing Y sere s
FCoo08 No errors identified in ODE processing A B Select Al) ~
FCO - Y
rcof Change the filter for the Student v
FCO R
-] Age Number column to include \‘Y\
FCO Y
«od all ages except 3,4, and 5 v
FCOOUE NG SITors [gemmiey m UoE processme._______ Y H v
FC0O008 No errors identified in ODE processing A
FCO008 No errors identified in ODE processing Y Cancel
\ FCoo08 No errors identified in ODE processing Y EMIS
g 48
\ Alliance
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" Add a Third Filter

| J K L M N o
“ FED CCT LEGAL DISAB STDNT
STATUS FED CCT FED CCT DISTOF CNDTN  AGE
CODE -1/ FED CCTSTATUS CODE DESCR ~ | FLAG -T|LRE COD| ~ |RES IRN ¥ | CODE, | * | NUMBE ~
FCO008 No errors identified in ODE processing 14| SortAtoZ 8
FCD008 No errars idenf . . . Z] setZtoA 4
FCO0DS  No errors idend] Add a thlrd fllter in o R 38
FC0008 No errors ident] = 6
rooooe noerrorsigen] the DISAB CNDTN a
FC0008 No errors iden{ 7
FC0008 No errors ident CODE COIumn Text Filters 3 1
FC0008 No errors identiTTed 1 ODE pToCessng, E— e 6
FC0008 Mo errors identified in ODE processing “eare 5
FC00038 No errors identified in ODE processing ;E‘EHA”] ~ 7
FC00038 No errors iden o2 7
FC0008 No errors iden Select one disa bility o3 3
FCO008  No errors iden . Llos 13
FC0008  No errors iden Code at a time gg: 4
FCO008 No errors iden [los 13
FC00038 Mo errors identified in ODE processing 0o 13
FC0003 No errors identified in ODE processing E 0 v 3
FC00038 Mo errors identified in ODE processing 10
FC0003 Mo errors identified in ODE processing Cancel 9
\ FCD008 Mo errars identified in ODE processing 12 EMIS
Th3g 49
\ Alliance
A B C i K L M N o] P Q
DISAB rencer lencor |oeror jowom e o
CNDTN STUDENT FLAG T|LRE COD|~|RES IRN ~ |CODE |[.¥|NUMBE|~|CODE |~ |DIST LRE SRC DESCR
I‘ Y IE15 404040 01 78 GE Record
10D DMLY DS ows || ey e o e
2 |- 3,4, and 5 Year Olds With a disability (Any) 32 I eis 208040 :‘;i e SE Recond
3 1 Multiple Disabilities (other than Deaf-Blind) 25 . 1E60 404040 (01 4l8 GE Record
Y IE15 404040 01 68 GE Record
4 2 Deaf'BllﬂdﬂeSS l \\ Y IE13 404040 01 20 8 GE Record
Y IE15 404040 01 88 GE Record
5 3 Deafness (Hearing Impairment) 1 B 39 go4040 01 192 Sent Reason = AU or JP
[ 4 Visual Impairments 5 v IE39 404040 01 7 A Sent Reason = AU or JP
Y
T Seethand anguage mpaimerts “ | | 1. From the filtered students on the
8 R . 10 B .
,| 2. This will match the count 2 | [F | FCC Detail Report, select a range
B “ ”
10l on the Statement of 9 » | of cells and see the “count” appear
11 93 v
| Assurances. . v | at the bottom of the spreadsheet.
Y
K L v liexs 404040 01 108 GE Record
13 13 Traumatic Brain Injury (TBI) 7
14 14 Other Health Impaired (Major) 3
15 15 Other Health Impaired (Minor) 56
16 16 Developmental Delay 0 : Count: 25 ) B o -

EMIS
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Quick Check

The Federal Child Count
Statement of Assurances
Report is derived from the
same data that is on the FCC
Detail Report. Using filters,
you can match the data
between the reports. The
Statement of Assurances is
sometimes requested by
auditors.

* Can you match the data between
the two reports using filters?

* Are you seeing the numbers of
students that you were expecting?

* Has this data been shared with
others in your district?

EMIS

51

Alliance

Summary

* The FCC Reports contain both data to verify and issues to

correct

* Some issues can be corrected, and some are simply stating
the fact that the student cannot be included in the count

* Work with district staff to verify that the data is both correct

and complete

* “No errors” does not necessarily mean that your data is

accurate

EMIS
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Resources

* Federal Child Count Detail Report and Federal Child Count
Statement of Assurances Report Explanation
* ODE Home > Data > EMIS > Documentation > EMIS Validation and
Report Explanations

* EMIS Manual
* ODE Home > Data > EMIS > Documentation > EMIS Manual

* Your district staff
* Your ITC

EMIS
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Questions?

If you would like a certificate of attendance for this
training, you must complete the below feedback form
within 5 business days of this training
https://tinyurl.com/EA-District-Feedback

EMIS
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